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Introduction 

In this chapter, you will obtain a general overview of managing requirements and you will 

learn about the different windows in the Rhapsody Gateway application. 

Product Overview 
Rhapsody Gateway is a requirements traceability solution that links your development and 

verification documents with formal requirements stored in documents and databases. 

Most engineering projects start by defining high-level specifications, followed by more 

specifications as the project progresses. Specifications contain technical and procedural 

requirements that guide the product through each engineering phase. In addition, working 
documents, such as hardware schematics, simulation models, software source code 

specifications and procedures must adhere to and cover the requirements defined by 

specifications. 

Rhapsody Gateway allows you to configure which specification and working documents 
to process, the type of traceability information to obtain from each type of document, and 

the traceability relationship between these documents. Rhapsody Gateway performs the 

coverage and impact analysis, graphically displays relationships between documents and 

generates reports. Rhapsody Gateway improves the impact analysis throughout a project 

lifecycle and the quality by managing requirements traceability. 

Rhapsody Gateway is an effective solution for enhancing project management traceability 

information, coming from any source. 

Rhapsody Gateway includes the following features: 

 Manage project documents and graphically create traceability relationships 

between documents 

 Customize types for importing various types of data from third party products 

 Use graphical, coverage analysis and impact analysis views to visualize and 

analyze traceability relationships between documents 

 Create filters to customize analysis and displays 

 Capture and compare project snapshots to determine changes in requirements and 

coverage 

 Generate reports using default and custom templates 
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Learning Rhapsody Gateway 
The best way to familiarize yourself with Rhapsody Gateway is to complete the following 

tasks: 

 Read this Getting Started guide to start with the main windows, concepts and 

features. 

 Train yourself with the Getting Started example. 

 Review the other sections in the User Manual and familiarize yourself with all the 

windows, features and analysis results calculations.
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Starting Rhapsody 
Gateway 

When you launch Rhapsody Gateway, the main window appears: 

 
 

Main Window 
The main window has four main parts: the menu bar, the toolbar, the project workspace, 

and the status bar. 

Menu Bar 

The menu bar contains the following menus: File, Edit, View, Tools, Reports and Help. 
Browse the menus in the main window to familiarize yourself with their contents. The 

status bar will display a brief explanation of the menu item as you hover over it with the 

mouse. 
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Toolbar 

The toolbar contains shortcuts to commonly used selections of the menu bar. As shown 

below, the toolbar contains the following sections: Standard, Configuration, 

Navigation, View Options, Filtering and Third Party. 

 
 

 Standard and Access Control (1)—Contains buttons for creating, loading and 

saving project files. Save is locked by user during modifications 

 Configuration (2)—Contains buttons for configuring projects, types, snapshots 

and options. Plug-ins can be added there. 

 Navigation (3)–Contains buttons for applying navigation commands previously 
performed within the coverage information of the Coverage Analysis, Impact 

Analysis views, Graphical View and Requirement Details. It is only available 

for these views. 

 View Options (4)—Contains buttons to control which requirement elements are 

visible in the Coverage Analysis, and Impact Analysis views. 

 Filtering (5)—Contains the Filter drop-down list box to configure and apply 

filters. These filters specify the conditions by which to include requirements in 

analysis or views. 

 Third Party Tools and Plug-ins (6)—Contains additional buttons that apply to 

specific third party products, such as DOORS, and/or plug-ins. 

Project Workspace 

The project workspace is the main area of the application. This area displays the project 

information and analysis for the loaded project. The project workspace contains multiple 

view tabs for displaying the contents of the project. Each view may contain one or more 

panes. 

The project workspace contains the following views: 

 Management View—Displays the documents in the project, the elements of each 

document, and a summary of coverage information for the project. 

 Coverage Analysis View—Displays one level of covering elements, N-1, and 

one level of covered elements, N+1, for a selected element of a document. These 

covered and covering elements come from other documents as defined by the 

project.  

 Impact Analysis View—Displays all levels of covering elements, N-m, and all 

levels of covered elements, N+p, for a selected element of a document. These 

covered and covering elements come from other documents as defined by the 

project. 
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 Graphical View—Displays each document graphically using a tree view with 
lines connecting requirement elements in documents and covering elements in 

other documents. 

 Requirement Details—Displays each requirement and its attributes for a 

document in a table. 

 Link Details—Displays covering information between a covering document and 

its covered documents. 

Status Bar 

The status bar displays common information in the application, such as descriptions for 

menus or status while performing analysis. 

Configuration Dialog Box 
Rhapsody Gateway launches the Configuration dialog box when you select a menu item 

or toolbar button to configure one of the following parts of your project: Project, Types, 

Snapshots, Filters, Reports, Expressions, XML or Options. 
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The Configuration dialog box contains the following panes: 

 Project—Allows you to configure the project by specifying the documents to 

include, the type of each document, and the covering relationship between 
documents. Refer to the Project Configuration chapter in the User Manual for 

more information about configuring projects. 

 Types—Allows you to create new types or customize existing types for your 

project. Refer to the Customization Guide for more information about 

customizing types. 

 Snapshots—Allows you to create, manage and compare snapshots of your 

project. Refer to the Managing Snapshots chapter in the User Manual for more 

information about using snapshots. 

 Filters—Allows you to define custom filters to analyze requirements and only 

display requirements from documents that meet specific criteria. You can enable 
filters using the Filter drop-down list box on the toolbar of the Rhapsody 

Gateway main window. Refer to the Filter section in the User Manual for more 

information about using filters. 

 Reports—Allows you to define new custom reports. You can generate a default 
report or a custom report using the Reports > Library Reports submenu on the 

main window. Refer to the Generating Documentation chapter in this Manual, and 

to the User Manual for more information about generating documents. 

 Expressions—Allows you to test regular expressions. You can specify source 

text and a regular expression, and the pane will display the captured text returned 

by the regular expression. 

 XML—Allows you to test XML syntaxes. You can specify source text and an 

XML syntax, and the pane will display the captured text returned by the XML 

syntax. 

 Options—Allows you to set the default font for text in the application, set the 
password on the project, and define environmental variables and other 

miscellaneous settings for the application.
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Managing 
Requirements 

In this chapter, you will learn about the different windows in Rhapsody Gateway by 
creating a project, adding existing documents to the project and reviewing the contents of 

the documents and the views in Rhapsody Gateway. 

A project specifies the documents that Rhapsody Gateway analyzes and displays, as well 

as the type of each document. A type defines how to select external files that represent a 

document, how to read the contents of the external files, how to interpret the contents as 

elements for managing requirements and how to display the elements of the document. 

Creating a Project 
The exercises in this manual use the files located in the Documents and 
Settings\<user>\My Documents\Rhapsody Gateway\<Rhapsody 

Gateway_version>\examples\Use Cases\GettingStarted directory(for 

Windows XP) 
 

Users\<user>\My Documents\Rhapsody Gateway\<Rhapsody 

Gateway_version>\examples\Use Cases\GettingStarted directory(for 

Windows 7) 

A Tutorial project example is delivered in this directory. 

To create your own Tutorial project, you will start the Rhapsody Gateway application and 

create a new project. You will add and configure documents in the project, review the 

contents of the documents and review the views in the Rhapsody Gateway project 

workspace. 

1. Launch the Rhapsody Gateway application by selecting Start > Programs > 

<Rhapsody Gateway group> > Rhapsody Gateway. You will now see the 

Rhapsody Gateway main window. 

2. Select File > New… to launch the Create a New Project and Save As dialog 

box and create the project. 

3. Enter MyTutorial in the File name field, select the directory to create the 

project then click Save. 

4. Rhapsody Gateway creates a new project file MyTutorial.rtqf in the selected 

directory and displays the Project pane of the Configuration dialog box as shown 

in the following figure. 
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A project file defines the documents in which Rhapsody Gateway will read the 

type of each document and the covering relationship between these documents. 

 
 

Adding a Document 
After you create your project, you will add a Microsoft Word specification document to 

the project. 

1. Click the Add a document  button. When you make this selection, the cursor 
automatically moves to the Traceability Description Area and the cursor outlines 
a document object. Click within this area to place the document. When you place 

the document, the document is added to the Project Tree pane. The Document 

Details Area displays the settings for the selected document. 

2. In the Document Details Area, click on the Name column to select the 

Document1 text. Type Product Specification and press <Enter> to 

rename the document. The name in the document object now displays the new 

name. 

3. Click on the Type of Analysis column. Select Word in the drop-down list box. 

4. Click on the File or Directory column. The File Browse button appears on the 

right side of the control. Click the File Browse button and select  
Documents and Settings\<user>\My Documents\Rhapsody 

Gateway\<Rhapsody Gateway_version>\examples\Use 

Cases\GettingStarted\ProductSpec.doc (for Windows XP) 
 



Managing Requirements 

 

 

IBM
®
 Rational

®
 Rhapsody

®
 Gateway Add On 

15 

Users\<user>\My Documents\Rhapsody Gateway\<Rhapsody 

Gateway_version>\examples\Use 

Cases\GettingStarted\ProductSpec.doc (for Windows 7). 

The following figure shows the completed Configuration dialog box. 

 
 

Adding a Covering Document 
A covering document is a document that contains references to requirements that are 

defined in another document. You will now add a new document to the project that covers 

the Product Specification document. 

1. Click the Add a document  button to add a second document object in the 

Traceability Description Area. Place the document below the Product 

Specification document. 

2. In the Document Details Area, configure the document as follows: 

 Name: Design Specification 

 Type of Analysis: Word 

 File or Directory: Documents and Settings\<user>\My 
Documents\Rhapsody Gateway\<Rhapsody 

Gateway_version>\examples\Use 

Cases\GettingStarted\CoveringSpec.doc (for Windows XP) 
 

Users\<user>\My Documents\Rhapsody Gateway\<Rhapsody 
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Gateway_version>\examples\Use 

Cases\GettingStarted\CoveringSpec.doc (for Windows 7)  

3. Click the Add a cover  button. The cursor moves to the Traceability 

Description Area. Click the Design Specification document object first and 

then click the Product Specification document object. An arrow appears 

between the two documents as shown in the following figure. This arrow 

indicates that the Design Specification document covers the Product 

Specification document. 

 
 

4. Click OK to save and close the Configuration dialog box. 
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Using the Management View 
After you close the Configuration dialog box, the main window appears as shown in the 

following figure. 

 
 

The Management View displays the project in the Project Overview area. The project has 

two documents and its coverage ratios is 83%.  

The Overall Quality pane indicates that the project has six requirements defined and one 

error which is an uncovered requirement. The percentage of requirements without errors is 

83%. 

Perform the following tasks to acquaint yourself with the Management View and the 

documents that you have included in the project. 

1. Right click the Product Specification in the Project Overview and select 

Navigate from the context menu. Rhapsody Gateway displays the 

ProductSpec.doc file in Microsoft Word. 

2. Review the contents of the file in Word. The file contains three types of elements: 
sections, requirements and text. The default Word type in Rhapsody Gateway 

interprets the contents of the file as follows: 

 A section is defined by Word heading styles. 

 A requirement is defined using the Word style ―Requirement_ID‖. This can 

be customized to capture an identifier that contains a set of arbitrary 

characters, and ends with a numeric value. The label for the requirement is 

after the identifier and is delimited by a colon character. 

 Any text using the Word style ―Requirement_Text‖ is associated with the 

previously specified element. If an initial text element is specified at the 

beginning of the file, the text is associated with the document. 



Managing Requirements 

 

 

IBM
®
 Rational

®
 Rhapsody

®
 Gateway Add On 

18 

 The ProductSpec.doc file specifies six requirements. The document can 

be closed. 

3. In Rhapsody Gateway, right-click the Design Specification in the Project 

Overview and select Navigate from the context menu. Rhapsody Gateway 

displays the CoveringSpec.doc file in Word. 

4. Review the contents of the CoveringSpec.doc file in Word. The file contains 

section and text elements, but instead of requirement elements, the file contains 

requirement references. A requirement reference is defined by the prefix 

characters [Covers:, followed by a set of characters that represent the 

requirement identifier, and completed with a closing bracket character. 

The CoveringSpec.doc file specifies five requirement references. Notice that 

the 1.2. USB 2.0 Speeds section of the document does not contain a 

requirement reference. This missing reference is discussed later in this exercise. 

The document can be closed. 
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Analyzing 
Requirements 

As explained in the previous chapter, Managing Requirements, the Management View 
summarizes the structure of the project and the coverage ratios. This chapter will teach 

you how to use the Coverage Analysis View, the Impact Analysis View and the 

Graphical View to obtain additional details about the requirements and the references that 

cover them. 

Analyzing the Project 
Complete the following steps to analyze requirement coverage for the project that you 

created in the Managing Requirements chapter. 

1. Select the Coverage Analysis View tab in the main window. Ensure that the 

Product Specification and the Design Specification document 

elements in the Selection tree view pane are collapsed. 

2. Click the Product Specification document element in the Selection 

column. 

 
 

3. The Downstream Coverage Information column displays that the Product 

Specification document is covered by the Design Specification 

document, and the document covers only 83% of the requirements. 
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4. Expand the child elements of the Product Specification document in the 

Selection column. 

Note 

To expand a parent element and all its child elements, press <Shift> while 

clicking the plus icon to expand the parent element. 

The tree view pane displays the section headings from the text file as parent 

elements and displays the requirements as child elements. 

5. Select the PS_USB_REQ1 requirement. The PS_USB_REQ1 element represents a 

requirement specified in the document. Select the Messages tab which indicates 

that the PS_USB_REQ1 element is a requirement and that this requirement is 

covered. The Downstream Coverage Information column displays the 1.1 

USB 1.0 Speeds section as a covering element because this section of the 

document contains a reference to the requirement. The tree view pane also 

includes the parent 1 USB Support section of the covering document. 

 
 

6. Select the PS_USB_REQ2 requirement. The Messages tab indicates that the 

PS_USB_REQ2 element is also a requirement; however, this requirement is not 

covered. Rhapsody Gateway highlights the name of the element in red. The 

Downstream Coverage Information column does not display any covering 
elements because the covering document does not contain a reference to the 

requirement. 
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Collapse the Product Specification document in the tree view pane of the 

Coverage Analysis View. 

7. Select the root element of the Design Specification document. The 

Messages tab indicates that the document contains references to five 

requirements. 

8. Expand the child elements of the Design Specification document in the 

tree view pane, as shown in the following figure. 

 
 

9. Select the 1.1 USB 1.0 Speeds element in the tree. This element represents a 

section specified in the document. The Messages tab indicates that the section 

contains a reference to one requirement. 

10. Select the 1.2 USB 2.0 Speeds element in the tree. The Messages tab for this 

element indicates that the section is empty and contains no references to any 

requirements. 

11. Collapse the Design Specification document in the tree view pane of the 

Coverage Analysis View. 

12. Expand the elements of the Rule check item of the Coverage Analysis View as 

shown in the following figure. The Rule check tree contains a summary of the 
rules flagged while analyzing the project. For this project, the pane indicates that 

the PS_USB_REQ2 requirement is uncovered. 

 
 

Refer to the Rules Check and Error Messages chapter of the User Manual for more 

information concerning the various rules that Rhapsody Gateway defines. 
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Using the Coverage Analysis View 
The Coverage Analysis View displays the immediate downstream and upstream 

document. In this section, you will learn how to add a cover to the project and how to use 

the Coverage Analysis View. 

Adding a Cover 

Complete the following steps to add a cover to the project that you created in the 

Managing Requirements chapter. 

1. Expand the child elements of the Product Specification document in the 

Selection column of the Coverage Analysis View. 

2. Fly over the exclamation icon, to the right of the PS_USB_REQ2 requirement to 

display a tip strip that contains the text, 1 uncovered requirement. The tree view 

pane displays the exclamation icon for an uncovered requirement and its parent 

elements in the document. 

3. Click the Analog Channels section as shown in the following figure. The child 

elements of the Analog Channels section contain two requirements: 

PS_AI_REQ1 and PS_AO_REQ1. The Downstream Coverage Information 

column displays both the 2.1 Analog Input and the 2.2 Analog Output 

sections as covering elements. In the covering document, the 2.1 Analog 

Input section contains a reference to the PS_AI_REQ1 requirement and the 2.2 

Analog Output section contains a reference to the PS_AO_REQ1 requirement. 

 
 

4. Double-click the 2.1 Analog Input section in the Downstream Coverage 

Information column. Rhapsody Gateway navigates to the 2.1 Analog Input 

section in the Selection column. The Upstream Coverage Information column 

displays that 83% of the requirements in the Product Specification 

document are covered by the Design Specification document, and that the 

PS_AI_REQ1 requirement is specifically covered by references from the 2.1 

Analog Input section in the Selection column. 
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5. Expand the 1 USB Support element of the Design Specification 

document to view the 1.2 USB 2.0 Speeds element. 

6. Double-click the 1.2 USB 2.0 Speeds element in the Selection column to 

open the CoveringSpec.doc file in Word. 

7. Edit the file by adding a reference to the PS_AI_REQ2 requirement below the 

1.2 USB 2.0 Speeds section as shown in the following figure. 

 
 

8. Save the changes to the CoveringSpec.doc file. 

9. Return to Rhapsody Gateway. When the main window of Rhapsody Gateway is 

displayed, the application prompts you indicating that the Design 

Specification document was modified. Click Yes to reload the file. 

Rhapsody Gateway analyzes the new document and updates the view as shown in 

the following figure. 

 
 



Analyzing Requirements 

 

 

IBM
®
 Rational

®
 Rhapsody

®
 Gateway Add On 

24 

The Upstream Coverage Information column now indicates that the Design 

Specification covers 100% of the requirements in the Product 

Specification document, the PS_USB_REQ2 requirement is now shown as 

covered by the 1.2 USB 2.0 Speeds element, and the orange icon for the 1.2 

USB 2.0 Speeds element and its parent elements indicate a change occurred. 

 

In summary, the Coverage Analysis View allows you to select elements from a project 
document and displays requirement coverage one level upstream and one level 

downstream from the selected document. 

 

In the next section, you will learn how to use the Impact Analysis View. 

Using the Impact Analysis View 
The Impact Analysis View displays traceability information from all downstream and 

upstream documents instead of only displaying the immediate downstream and upstream 

document. In this chapter, you will learn how to add a third document to the project and 

how to use the Impact Analysis View. 

Modifying a Document 

Complete the following steps to modify an existing document to the project that you 

created in the Managing Requirements chapter. 

1. Select File > Edit Project to launch the Project pane of the Configuration dialog 

box. 

2. Click the Design Specification object in the Traceability Description Area. 

3. In the Document Details Area, reconfigure the document as follows: 

 Name–Design Specification 

 Type of Analysis–Word 

 File or Directory–Documents and Settings\<user>\My 
Documents\Rhapsody Gateway\<Rhapsody 

Gateway_version>\examples\Use 

Cases\GettingStarted\DesignSpec.doc (for Windows XP) 
 

Users\<user>\My Documents\Rhapsody Gateway\<Rhapsody 

Gateway_version>\examples\Use 

Cases\GettingStarted\DesignSpec.doc (for Windows 7) 
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Adding a Second Downstream Document 

Add a third document to the project. 

1. From the Project editor, click the Add a document  button to add a third 
document object in the Traceability Description Area. Place the document below 

the second document. 

2. In the Document Details Area, configure the document as follows: 

 Name–Test Specification 

 Type of Analysis–Word 

 File or Directory–Documents and Settings\<user>\My 
Documents\Rhapsody Gateway\<Rhapsody 

Gateway_version>\examples\Use 

Cases\GettingStarted\TestSpec.doc (for Windows XP) 
 

Users\<user>\My Documents\Rhapsody Gateway\<Rhapsody 

Gateway_version>\examples\Use 

Cases\GettingStarted\TestSpec.doc (for Windows 7) 

3. Click the Add a cover  button to add a covering link. Click the Test 

Specification document object first and then click the Design 

Specification document object to create an arrow between the two 

documents, as shown in the following figure. 
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4. Click OK to save and close the Configuration dialog box. Click Yes when 
Rhapsody Gateway prompts you to reanalyze the project. Your new project is 

now properly configured to analyze the new documents. 

Return to the Rhapsody Gateway main window and select the Impact Analysis View tab. 

Collapse the three document elements in the Selection column. 

Reviewing the New Documents 

Complete the following steps to review the contents of the two new documents. 

1. Double-click the Design Specification element in the Selection column to 

display the DesignSpec.doc file in Word. 

2. Review the contents of the file in Word. The DesignSpec.doc file contains 

similar sections and text elements as found in the CoveringSpec.doc file, 

however the DesignSpec.doc file also contains 24 additional requirements. 

These additional requirements are covered by references in the Test 

Specification document. The following figure displays the 1.1 USB 1.0 

Speeds section of the file, which contains a reference to the PS_USB_REQ1 

requirement and contains two additional derived requirements, DS_USB1_REQ1 

and DS_USB1_REQ2. A derived requirement is a requirement that is defined in a 

document but is not directly associated with the coverage of an upstream 

document. 

 
 

To associate a requirement with the coverage of an upstream document, the 

requirement must be specified immediately before the reference that covers the 
upstream document as shown in the following figure. These requirements are 

sometimes referred to as non-derived or low-level or design requirements. 
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Rhapsody Gateway displays derived and non-derived requirements in the Impact 

Analysis View. 

3. Double-click the Test Specification element in the Selection column to 

open the TestSpec.doc file in Word. Review the contents of the file in Word. 

The TestSpec.doc file contains references for 24 requirements specified in the 

Design Specification document. 

Performing Impact Analysis 

Complete the following steps to learn how to analyze the new documents using the 

Impact Analysis View. 

1. Expand the Design Specification document in the Selection column, as 

shown in the following figure, to display the derived requirements, 

DS_USB1_REQ1 and DS_USB1_REQ2, and the non-derived requirements, 

DS_USB2_REQ1, DS_USB2_REQ2 and DS_USB2_REQ3. 

Rhapsody Gateway displays different icons for derived and non-derived 

requirements and displays a navigation arrow icon on the right side of the column 
to highlight derived requirements. Derived requirements are also added to the 

Rule check information. 
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The  icon indicates that an error exists. In this example, the error is :"The target 

requirement of reference PS_AO_REQ199 has not been found anywhere in the 

project". 

2. Expand the Product Specification document, as shown in the following 

figure, and select the PS_USB_REQ1 requirement. The Downstream Impact 

Information column displays the covering 1.1 USB 1.0 Speeds section from 

the Design Specification document. 

 
 

3. Select the PS_USB_REQ2 requirement as shown in the following figure. The 

Downstream Impact Information column displays the non-derived 

requirements from the covering Design Specification document. It also 

shows the sections from the Test Specification document that covers the 

non-derived requirements. 
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In the next section, you will learn how to graphically view traceability information. 

Using the Graphical View 
Complete the following steps to graphically view your project documents. 

1. Select the Graphical View tab. The Graphical View displays each document as 
an object with its traceability elements displayed in a tree view within the object. 

Thin, black lines represent covering references between requirements elements of 

a document and elements in another document. You can also reposition 

documents, adjust the width of the documents, pan, zoom and resize the 

containing page. 

2. Click the PS_USB_REQ2 element in the Product Specification document. 

When you make this selection, the view highlights the PS_USB_REQ2 element, 

the covering DS_USB2_REQ1, DS_USB2_REQ2 and DS_USB2_REQ3 

requirements, their coverage by Test Specification and the lines between 

the elements, as shown in the following figure. 

 
 

3. Right-click the PS_USB_REQ2 requirement and select View Graph for Selection 

from the context menu. When you make this selection, the view only displays the 

highlighted elements from the three documents, as shown in the following figure. 
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4. Right-click in the view and select Show All Elements from the context menu to 

show all the elements of the documents again. 

 

Below are listed some actions to perform within the Graphical View. 

 Click the header of the Test Specification document. When you make this 

selection, the entire document is selected. 

 Right-click the Test Specification document and select Hide Selected 

Documents from the context menu. When you make this selection, the view hides 

the Test Specification document and displays the traceability information 

for the remaining two documents. 

 Right-click in the view and select Show Hidden Elements in the context menu to 

display all the documents again. A dialog opens to select the document to show 

again. 

 Move documents within the Graphical View by selecting the document header 

and dragging the header to a new location. 

 Zoom in and out by pressing <Ctrl> while rolling your mouse wheel up or down. 
You can also select either Zoom > 100% or Zoom > Fit in page from the context 

menu. 

 Resize the width of a document by selecting the document header and dragging 

the resize handles that appear on the right side of the document. Consult 

following figure. 

 Expand and collapse the sections by clicking the plus sign. You can also right-

click the header of a document and select Collapse Root Sections or Expand All 

Sections from the context menu, as shown in the following figure. 

 
 

 

In the next chapter you will learn how to generate reports for a project. 
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Generating Reports 

In this chapter you will learn how to generate reports and create customized reports. 

Generating a Built-in Report 
Rhapsody Gateway installs the following Library Reports: 

 Traceability Matrix—Lists the upstream to downstream covered links and the 

downstream to upstream covering links. 

 Analysis Results—Summarizes the coverage analysis for a project. 

 Project Description—Describes the project and its documents. 

 Upstream Impact Analysis—Lists the upstream traceability information for 

selected elements of the project. 

 Downstream Impact Analysis—Lists the downstream traceability information 

for selected elements of the project. 

 Synthesis of Added Information—Summarizes any added attributes, references, 

text and covering links in the project. 

 Rules Checking—Contains a summary of any rules highlighted by the project. 

 

Complete the following steps to generate a Project Description report for your project. 

1. Select Reports > Library Reports > Project Description to display the Save As 

dialog box. 

2. Enter ProjectDescription.rtf in the filename control and click Save. 

Rhapsody Gateway generates and displays the report file in Microsoft WordPad 
or Microsoft Word, as shown in the following figure. Review the contents of the 

report. 
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You have completed this tutorial. Refer to the User Manual for more detailed information 

about all the windows, features and concepts introduced here. 

 

We started with a demo example that is very simple, but consistent with what you can 

experiment when you switch to a more complex process for requirements management: 

 More advanced and more specific Types of analysis can be created using the 

Customization Guide. Those types can be used to analyze Word files, as well as 

information from other text processing tools, requirements management tools 
(DOORS, RequisitePro, etc.), modeling tools, verification tools, code files and so 

on. However, for user project it still exists ready-to-use types like the ―Word‖ one 

used in this tutorial. 

 More advanced processes can be defined, with a larger number of documents and 
more complex relationships, but you will have to use the same Project Editor 

window, and use the same feature to add new documents, new coverage links, etc. 


	Contents
	Introduction
	Product Overview
	Learning Rhapsody Gateway

	Starting Rhapsody Gateway
	Main Window
	Menu Bar
	Toolbar
	Project Workspace
	Status Bar

	Configuration Dialog Box

	Managing Requirements
	Creating a Project
	Adding a Document
	Adding a Covering Document
	Using the Management View

	Analyzing Requirements
	Analyzing the Project
	Using the Coverage Analysis View
	Adding a Cover

	Using the Impact Analysis View
	Modifying a Document
	Adding a Second Downstream Document
	Reviewing the New Documents
	Performing Impact Analysis

	Using the Graphical View

	Generating Reports
	Generating a Built-in Report


